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Network Testing and Emulation Solutions

Various Techniques Cookbooks
The Various Techniques Cookbooks provide miscellaneous examples of how to perform various network
configuration tasks. Each is a set of step-by-step instructions intended to help build your familiarity with network
configuration in Linux and Windows.
Please contact us at support@candelatech.com if you have any questions.

All Network Configuration Cookbook Examples
1. Configure Auxiliary Management
2. Find Windows IP Addresses
3. Find Windows MAC Addresses
4. Custom DOS Window Settings
5. Quickly Inspect Your DOS PATH Variable
6. Connecting With PuTTY
7. Install Arduino Mega Driver on Windows XP
8. Install Arduino Mega Driver on Windows 7
9. Install Arduino Mega Driver on Windows 10
10. Connect to LANforge Using Remote Desktop
11. Connect to LANforge Using VNC Viewer
12. Display WireShark Using Cygwin
13. Finding Report Data
14. Writing Disk Images on Windows
15. Adding a LANforge Virtual Machine
16. Configuring Serial Connection to LANforge
17. Connecting SMA Cables to LANforge
18. Diagnose GUI Problems on Windows
19. Recovering Filesystems
20. Automatically Start LANforge GUI on Login
21. Configure OpenVPN on Ubuntu
22. Configure OpenVPN on Windows
23. CI/CD Lights-Out Chamber Setup
24. Instructions to Change Report Logo
25. Instructions to Set Up an SSH Tunnel
26. Understanding VRF Devices
27. Use FireFox with a Virtual Station to Browse a DUT
28. Backing Up and Migrating LANforge Data
29. CT714B Stand Assembly
30. CT840a Turntable Testing
31. Remove old Reports and Data
32. Clustering Multiple LANforge Systems
33. LANforge Troubleshooting

Configure Auxiliary Management
Interfaces
Goal: Allow LANforge to create its own wireless management network.
In cases where is is not convenient to use an existing management network, LANforge WiFi systems can be
configured to provide their own WiFi management network. This may be especially useful when testing in
environments where LANforge needs to be moved around or where you have no good access to existing
management LANs. This example assumes that you already know how to create and configure VAP and
Stations in LANforge.

1. Configure LANforge for Auxiliary Management.

A. Connect LANforge systems through the normal management LAN for initial configuration. The
resources should be visible in the management tab

B. In this case, we are using wiphy0 for the Aux-Mgt interfaces. On the manager system, configure
wiphy0 to be on the desired channel, create a virtual AP on wiphy0, and configure it appropriately.
The Aux-Mgt checkbox should be selected, a static IP should be assigned, and an appropriate SSID
configured. The AP Aux-Mgt port will automatically serve DHCP and will try to NAT and route
packets to the wired Management interface.

C. On the other resources, configure the wlanX interface to connect to the AP on the manager system,
and select the Aux-Mgt checkbox.

D. The Port-Mgr tab should look something like this when the Aux-Management interfaces are
configured.

E. To test that it works properly, you can now remove the wired Manament port connection and wait
about 1 minute for the old connection to time out and re-connect to the Auxiliary Management
port. Or, just reboot systems with the wired ports unplugged and they should be discovered on the
Aux-Mgt ports promptly.

Windows IP Addresses
Goal: Find and change network ip addresses on Microsoft Windows.
Here are some techniques for finding and setting IP addresses on
Microsoft Windows using the Control Panel and the command line.

1. Find the IP Address of the Windows PC. There are two methods you can use:
A. Using the Control Panel:
A. Click Start, Run, control , [enter]

B. Search and select Network Status and Devices

C. We click on our device, Ethernet 3:

D. Find and/or set the IP address: from Status, click Properites

E. double click TCP/IPv4

F. you will see and can change the IP address.:

B. Various DOS commands to find the IP addresses on the system:
A. ipconfig and ipconfig /all
B. netsh interface ipv4 show address
C. Resetting your DHCP address via command line:
A. ipconfig /release
B. ipconfig /renew

Windows MAC Addresses
Goal: Find MAC Addresses in Microsoft Windows.
Here are some techniques for finding MAC addresses on Microsoft
Windows using the Control Panel and the command line.

1. Find the MAC Address of the Windows PC. There are two methods you can use:
A. Method 1: use the Control Panel
A. Click Start, Run, control , [enter]

B. Search and select Network Status and Devices

C. We click on our device, Ethernet 3:

D. Click Details...

E. Details will show the MAC address (physical address):

F. (Suggested) Set the IP address if you have not already. For more information see Finding
Windows IP Address
B. Method 2: use the DOS command-line. You want to correlate the IP address and MAC address of
the Windows ethernet port:
A. Click Start, Run, and type cmd , and press [Enter]

B. Show interfaces by name with the command: netsh interface ipv4 show addresses

C. (Optional) if you do not see results, you might need to start the network autodiscovery
service: net start dot3svc

D. (Optional) Depending on the edition of Windows, the command
netsh lan show interfaces will display mac addresses.

E. Show mac addresses with: getmac /v /fo csv
(The CSV formatted command of the command ensures that we will see the entire name of the interface which
can be trimmed short in the default output format.)

F. These commands will make it easier to copy using notepad:
netsh interface ipv4 addresses > ifnotes.txt
getmac /v /fo csv >>ifnotes.txt
notepad ifnotes.txt

G. Now you can easily copy the values:

Customizing DOS Window Settings
Goal: Make your DOS windows large and do cut and paste easier.
Here we review DOS window settings that will help you to work
faster.

1. Customizing DOS Window Settings starts by right clicking the Start Menu
2. Type in cmd and hit Enter

3. To get to your DOS window faster, you can pin it to your task bar. Right click the task bar CMD window icon
and select Pin this program to taskbar

4. On the DOS window title bar, Right click and select the Defaults menu item

5. Select the Quick Edit Mode setting. This allows you to highlight text in the window easily.

6. In the Font tab, select a slimmer TrueType font, like Consolas or Lucida Console, and set the font size to 10

7. In the Layout tab, change the Window Size to 132 columns and 56 rows

8. Click OK to save. The next DOS window you open will appear with your customized settings.

Quickly Inspect Your DOS Path
Goal: Find if a program or is in your %PATH%
Use this technique to inspect your DOS environment variables for
specific strings using findstr .

1. Follow this example to see if perl is installed and your %PATH% environment variables is updated. First, open
up a DOS window: Windows + R cmd Enter
2. Type in the DOS Window: echo %PATH% | findstr /i perl Enter
3. If perl is installed correctly, you should have it in your path.

4. You can also use this technique to find any environment variable. E.G., find if you have a temporary
directory set:
set | findstr /i temp

Connecting with PuTTY
Goal: Using PuTTY on Windows to connect to LANforge Linux servers.
Lots of tasks, like scripting, can be done over SSH from your Windows
desktop. Here are a few steps to help you customize your PuTTY
terminal to work faster.

1. Configuring a PuTTY Session
A. When you double click on the PuTTY icon and it launches, you can start customizing your session
preferences. We'll name this session jedtest

B. Let's default the window to something large, like 120 columns and 56 rows.

C. The Fixed font can be replaced with the Consolas font.

D. Let's turn on TCP Keep-alive and set IPv4 as the default networking protocol.

E. We login to LANforge resources with user lanforge

F. Generating a SSH keypair is not difficult. Let's enter the path to our public key file.

G. We have done our PuTTY config. Now back to the top Session screen, and click Save

2. Configure Pagent with your public key
A. Create your own public ssh key. For more information see WinScp Net
B. Start Pagent. Configure it to load on startup.
C. In the System Tray you will see the Pagent icon.

D. Right-click the Pagent icon and click Add Key to select your key

E. You will need to provide your pass-phrase to load your key

F. We see a loaded key

G. Here is our key, we will view the .pub file to copy out the public key.

H. In a putty window you will log into your LANforge server and edit
/home/lanforge/.ssh/authorized_keys

I. Copy the text and place the "Comment" section at the end when you paste it into your ssh

J. Here is the public key string, with newlines and spaces removed. The Comment text goes at the end.

K. Check the permissions of the authorized_keys file. You might need to use the command
chmod 600 authorized_keys
to correct the permissions.

L. The next time we load the jedtest PuTTY session we should not be prompted for our password.

Installing the Arduino Mega Driver on
Windows XP
Goal: Installing the the Arduino Mega device driver on Windows XP.
The automatic driver install process for Windows XP might automatically install a Microsoft Windows version of
the Arduino Mega driver. This is not the driver LANforge expects. These instructions will guide you how through
uninstalling an old driver and installing the new driver.

1. Follow the link to the Arduino project to download the latest driver :Download Arduino IDE For more
information see Installing LANforge Server on Windows
2. Download the Arduino IDE zip file to your desktop. Use Right-click→Extract All... to expand the contents to a
folder on your desktop.

3. Connect USB cable from the Attenuator to the PC
4. Click Start→Control Panel and choose the Add Hardware option.

5. In the hardware list page, select Add a new hardware device, and click Next

6. Select the Install the hardware that I manually select option, and click Next

7. Select the Ports (COM & LPT) option, and click Next

8. Select (Standard port types) option, then Communications Port and then click Have Disk...

9. Click Browse

10. Navigate to your Desktop\arduino-1.8.9\drivers folder, and click Open

11. Click Next

12. Click Next

13. Click Continue Anyway

14. Click Finish

15. You should not need to reboot your system in order to run the Attenuator
16. For LANforge to recognize the new attenuator, restart the LANforge server on the machine that has the
attenuator connected. On Windows, close the LANforge server CMD windows and then restart LANforge
with using your desktop icon.

Installing the Arduino Mega Driver on
Windows 7
Goal: Installing the the Arduino Mega device driver on Windows 7.
LANforge CT70x attenuators require recently signed Arduino drivers. The automatic driver install process for
Windows 7 might automatically install a Microsoft Windows version of the Arduino Mega driver. This is not the
driver LANforge expects. These instructions will guide you how through uninstalling an old driver and installing
the new driver from the Arduino website.

i

If you have recently removed a driver, you might need to reboot your Windows
system for it to complete the driver installation process.

1. You want to install the windows version of the LANforge Server beforehand. For more information see
Installing LANforge Server on Windows
2. Follow the link to the Arduino project to download the latest driver :Download Arduino IDE

3. Download the Arduino IDE zip file to your desktop. Use Right-click→Extract All... to expand the contents to a
folder on your desktop.

4. This process requires you to operate the Control Panel as Administrator. Some patch-levels of Windows 7
have secured this. A useful work around for this will be discussed shortly.
5. Getting to the Device Manager
A. In Control Panel, select Hardware and Sound

B. Select Device Manager

C. In the Device Manager window, right-click on the computer and select Scan for hardware changes

A. There will be an Other devices→Unkown Device entry. Right-click on it. If the options menu
only gives you either Scan for hardware changes or Properties, you might need to restart
your control panel as Administrator, that is discussed next.
B. Using the Run as Administrator option to start the Control Panel in administrator mode.
I. This works best with a CMD window pinned to the task bar. You can do that using
Start Menu→ cmd ENTER ; and then right-click→ Pin to Task Bar option on the
task bar icon for the cmd.exe window.
II. Then right-click→ Run as Administrator on the CMD taskbar icon

III. Repeat your navigation steps to get to the Device Manager

6. Uninstall Old Driver
If you find a previously installed driver, uninstall it. Especially if this is labeled Windows Arduino Mega
A. Right-click → Uninstall

B. Select Delete the driver software for this device, and click OK

C. Right-click on the computer, and select Scan for Hardware Changes
D. You might need to un-plug and plug-in your Attenuator.

E. If the right-click options menu does not allow you to change drivers, reboot your system.

7. Install new driver
Select Browse my computer for driver software
A. Browse to Desktop\arduino-1.8.9\drivers and click Next

B. You will see the Update Driver Software confirmation. Click Close.

8. You should not need to reboot your system in order to run the Attenuator.

Installing the Arduino Mega Driver on
Windows 10
Goal: Installing the the Arduino Mega device driver on Windows 10.
LANforge CT70x attenuators require recently signed Arduino drivers. The automatic driver install process for
Windows 10 might automatically install a Microsoft Windows version of the Arduino Mega driver. This is not the
driver LANforge expects. These instructions will guide you how through uninstalling an old driver and installing
the new driver from the Arduino website.

i

If you have recently removed a driver, you might need to reboot your Windows
system for it to complete the driver installation process.

1. You want to install the windows version of the LANforge Server beforehand. For more information see
Installing LANforge Server on Windows
2. Follow the link to the Arduino project to download the latest driver :Download Arduino IDE

3. Download the Arduino IDE zip file to your desktop. Use Right-click→Extract All... to expand the contents to a
folder on your desktop.

4. This process requires you to operate the Control Panel as Administrator.
5. Getting to the Device Manager
A. Type Control-F for Find
B. Search for Device

C. Select Device Manager

D. In the Device Manager window, right-click on the computer and select Scan for hardware changes

6. If you find a previously installed driver, uninstall it. Especially if this is labeled Windows Arduino Mega
A. Right-click → Uninstall

B. Select Delete the driver software for this device, and click OK

C. Right-click on the computer, and select Scan for Hardware Changes
D. You might need to un-plug and plug-in your Attenuator.
E. If the right-click options menu does not allow you to change drivers, reboot your system.

7.

Install the Arduino IDE Driver

A. In Device Manager, you want right-click on the Unknown Device and select Update Driver
Software...

B. Select Browse my computer for driver software:

A. Browse to Desktop\arduino-1.8.9\drivers and click OK

B. Click Next

C. You will see the Update Driver Software confirmation. Click Close.

C. You should not need to reboot your system in order to run the Attenuator.

Connect to LANforge using Remote
Desktop
Goal: Operate your LANforge's Linux desktop by accessing it with Windows Remote Desktop
utility.
LANforge computers on Intel hardware are typically installed with a
full Linux desktop. You can use the LANforge GUI, do traffic sniffing,
open terminal windows, and office software to look at report data
over remote desktop. LANforge computers are pre-configured with
RDP and VNC desktop services.

1. From your Windows Start Menu, type "remote" and Remote Desktop Connection should be an option.

2. If you are using the Start→Run menu, type mstsc Enter

3. If you want to create a desktop shortcut, explore the folder C:\windows\system32 and right-click mstsc.exe
4. Configure your connection:
A. Fedora version 24 and 25 have a bug in the vncserver triggered by xrdp. The effective way to use
rdesktop on those systems is to select an Xorg session for connecting (not a Xvnc session).
B. When connecting to Fedora 14-23 systems:
A. User Name: lanforge

B. You will not need to fill out the xrdp login screen.

C. When connecting to Fedora 24-25 systems:
A. Do not specify a user name, and select Always ask for credentials.

B. Select Xorg as the session type

C. Specify username lanforge and password lanforge

D. Local Resources

A. If your rdesktop session immediately closes, you might have hit the xrdp clipboard bug. If
so:
B. For Windows Remote Desktop (mstsc.exe): unselect Local Devices→Clipboard
C. For Linux rdesktop , use the command: rdesktop -a16 -r cliboard:off -u lanforge
[machine-name]

E. Disable remote audio settings

F. Disable local printers

G. Set Server authentication to Connect and do not warn

H. Connection quality can be 16-bit (millions of colors)

5. Click Connect to connect to the default desktop, the default password is lanforge

6. When you are DONE with your connection, you may close the Remote Desktop window. You will not be
logged out. However, if you log in without setting the Username option, you will be logged into a new session
alongside your old session. If you see this screen below, you are starting a new desktop session:

7. To reconnect to your previous desktop session, make sure you use the Username lanforge in your
connection settings.
8. To logout of the desktop session, select System→Log Out from the top window of the Linux desktop.

Connect to LANforge using VNC Viewer
Goal: Operate your LANforge's Linux desktop by accessing it with the VNC Viewer utility.
LANforge computers on Intel hardware are typically installed with a
full Linux desktop. You can use the LANforge GUI, do traffic sniffing,
open terminal windows, and office software using a VNC Viewer
program. LANforge computers are pre-configured with RDP and
VNC desktop services.

1. You can download a variety of viewers:

A. Check for viewer packages on your LANforge web page: http://192.168.1.101/

B. or download RealVnc
C. or download TightVnc

2. From your Windows Start Menu, type "vnc" and VNC viewer should be an option.

3. If you are using the start menu, it will be under either in All Programs > RealVNC or TightVNC

4. Double click the vnc icon and it will ask you for the IP address. You want to set the Encryption option to off
because we presume you are connected directly to the LANforge.

5. VNC Viewer might warn you about connecting without encryption. This is a valid warning if you are
connecting across public networks.

6. The password is lanforge .

7. You will see the LANforge Linux desktop. This is not the same desktop that is actually running on the console if
you have a monitor and keyboard connected.

8. When you are done with your connection, you may close the VNC viewer window. You will not be logged
out. When you connect using VNC viewer again, it show the current state of that desktop. connect you to
the last used VNC session.
9. To restart the vnc desktop session, select you can issue either of these two commands. You start using ssh
(PuTTY et. al.) to connect as lanforge to the LANforge machine, and:
A. sudo systemctl restart "vncserver@:1.service"
B. or
C. sudo vncserver -kill :1

Display WireShark Using Cygwin
Goal: We will display the WireShark application on Windows using Cygwin when we press
Sniff Packets which actually runs WireShark on the Linux LANforge machine.
The native display protocol for Linux (and Unix) is the X Display
Protocol. The Cygwin.org project provides Linux software that runs
natively on Windows. You can run an X display server on Windows
that accepts connection from LANforge. We will walk through
setting up Cygwin and configuring an X display.

1. Installing Cygwin and the X display components
2. We will start at Cygwin.org and download the Cygwin installer.

3. Download setup-x86.exe or setup-x86_64.exe as appropriate. Go to your Downloads folder and double
start the program.

4. Next

5. Next

6. Next

7. Choose a mirror that might be close to you, click Next

8. Now you see a the software selection screen, sorted by category. Some of these entries appear two or more
times, because they belong to multiple categores. Try using the search box in upper middle above the
software list to search for the packages listed below.

9. The items you want to search for are
openssh
xorg-server
xinit
rxvt
xlaunch
A. Search for openssh and click the Skip property once to change it to the most recent version to set it
to install.

B. xorg-server provides the X display system

C. xinit helps the X system launch

D. xlaunch is what you will drag to your task bar to launch your Cygwig X server

E. rxvt and rxvt-unicode are more useful terminals than the minterm program that Cygwin provides
by default.

10. Click Next and let the installer finish the installation of the Cygwin packages. You will see a Cygwin Terminal
icon appear on your desktop and new Cygwin icons in your Start menu.

11. Next we will right-click on the Cygwin Terminal icon and select Open File Location

12. In the Explorer window, scroll to find xlaunch.exe , and drag it to the Task Bar

13. Click the xlaunch icon on the task bar, and click Next

14. Next

15. Check Disable Access Control and add the option: -listen tcp. Click Next

16. Firewall, Click Allow Access

17. If the LANforge Messages window reports 'No Access', you might need to use xhost.exe to grant X11
access.

A. Open a CMD window

B. Go to the cygwin\bin folder:
C:\> cd \cygwin\bin
C. Use xhost.exe to open permissions:
C:\> .\xhost.exe +

18. Now your X display service is running. You can check that it's running by clicking into the System Tray and
seeing if the icon is there.

19. Launch the LANforge GUI from your desktop. Select a port from the Port Mgr tab. Notice how the Disp field
has your laptop's LAN address. This is the display address the remote machine will display the Wireshark
window to.

20. You will see WireShark

21. Resources and other Documentation:
A. http://unix.stackexchange.com/questions/227889/cygwin-on-windows-cant-open-display
B. https://www.cs.virginia.edu/~csadmin/wiki/index.php/Using_Cygwin_for_X11_Forwarding
C. http://www.arsc.edu/arsc/knowledge-base/ssh-and-x11-forwarding-us/index.xml

Finding LANforge Report Data
Goal: Properly configured, the LANforge server or the LANforge GUI can collect connection
performance information in CSV format.
By default, your LANforge server and your LANforge client do not save the data on
connection and port performance. When you configure the save destination for this
data, you can use it with any other tool that can read a CSV file.

Finding LANforge Report Data
Select your Save Location
You can tell the LANforge server to save data to a directory locally on the management machine, and you
can configure your workstation running the the LANforge GUI to save data to a local desktop folder. First, find
the Reporting Manager dialog by in the Reporting menu, and select Report Manager the client.

GUI Data Collection (Desktop Folder)
Collecting data on your local workstation is very convenient if you can leave the GUI running for the duration
of your test scenario. The format of the data here should be similar to the format of the data saved to the
server directory. The folders for collecting data are relative to the folder you start your GUI from. If you type in
lf_data that probably means C:\Users\mumble\AppData\Local\LANforge-GUI\lf_data . You probably want
to put in a fully qualified path thats more intuitive, like C:\Users\mumble\Documents\lf_data .

Generate Report
The Report Generator uses the local data files. In that dialog shows the Report Input Directory field is a local
folder where the CSV files collect. The Save Reports to Directory field is where HTMl and PDF files should collect.

Server Data Collection (Server Directory)
If your test scenario runs longer than your GUI can be up, you can configure the LANforge server to collect the
data. The directory is relative to the /home/lanforge directory, so if you enter lf_data , you would find the CSV
files in /home/lanforge/lf_data .

You can take a look at the data files easily. Here is a server data collection directory:

And using a utility like notepad , vi , more or less you can look at the file contents:

Using Libre Office
Importing the file into a spreadsheet like LibreOffice Calc is simple:

You only need to separate on comma (,)

The timestamp column
Libre Office does not have a builtin formula to do this, but it has been discussed here. And the solution is a
formula that looks like this:

=(A2/86400)+25569
and then you format the column as Date.

Scripting with Bash
There are a number of ways to collect an dort the data with shell utilities. The first utility to consider is cut , then
awk . The first column of the endpoint file we are going to read is the timestamp, the 14th is the rx bytes.

Reading the Data and RX Bytes
Converting Unix Date

$ head -n2 c201-A_1488414451.csv | cut -d, -f1
TimeStamp
1488414454125
$ date -d @1488414454125
Mon Dec 23 19:28:45 PST 49135
Using bash

$ head -n2 c201-A_1488414451.csv | (while IFS=, read -a L; do echo ${L[13]}; done)
rx_bytes
33847640064
Using cut

$ head -n2 c201-A_1488414451.csv | cut -d, -f14
rx_bytes
33847640064
Using awk

$ head -n2 c201-A_1488414451.csv | awk -F, '{print $14}'
rx_bytes
33847640064
head -n2 c201-A_1488414451.csv | awk -F, '{print $1 "\t" $14}'
TimeStamp
rx_bytes
1488414454125
33847640064

Scripting with Perl

It is a lot easier to do math with a perl script than a bash or an awk script. You can pipe things into perl or perl
will read the last argument of the -ne switches as an input file.

$ head -n2 c201-A_1488414451.csv \
| perl -ne '@v=split(/,/,$_); print "$v[0]\t$v[13]\n";'
TimeStamp
rx_bytes
1488414454125 33847640064
perl -ne 'BEGIN{$tt=0;@tstamps=();@rxb=();} \
{@v=split(/,/,$_); push(@tstamps, $v[0]); push(@rxb, $v[13]);} \
END{$dt=$tstamps[$#tstamps] - $tstamps[1]; $db=$rxb[$#rxb] - $rxb[1]; \
print "Time: $dt, Total:$db\n";}' \
c201-A_1488414451.csv
Time: 18959363, Total:1213399040
Not everthing you do in perl is going to be a one-liner. Here's an example of the same script as a more properly
formatted perl file:

#!/usr/bin/perl
my $tt=0;
my @tstamps=();
my @rxb=();
while(<>) {
@v = split(/,/, $_);
push(@tstamps, $v[0]);
push(@rxb, $v[13]);
}
$dt = $tstamps[$#tstamps] - $tstamps[1];
$db = $rxb[$#rxb] - $rxb[1];
print "Time: $dt, Total:$db\n";

Writing Disk Images on Windows
Goal: Copy an installed OS file-system image onto a drive that you will install into a LANforge
system that lacks display hardware.
Many LANforge ICE WAN emulator machines are embedded
systems that lack display hardware. Installing an OS using only the
serial console can be very inconvenient. The easy solution is to
perform the installation on similar hardware that does have display
hardware, and then move the drive to the embedded device.
Here, we learn how to use Etcher on Windows to write a
compressed disk image to an mSata drive plugged into a USB3
adapter.

1. Here we're using Etcher which handles compressed file system images without any trouble. There are other
programs (like Win32 Disk Imagaer or dd for windows) but those are more complex to use.
2. Items we'll want:
A. 30GB or larger mSATA drive

B. USB3 mSATA drive adapter

C. The image writing program Etcher

3. Download and install Etcher

4. Identify your drive in Control Panel → Hardware and Sound → Hardware and Printers.

5. Download your image file:

6. Start Etcher

7. Select the compressed image:

8. Select the removable drive

9. You might have to enable unsafe mode if the drive you plugged in has previously been used

A. in Settings, enable Unsafe mode

B. Select the removable drive

10. Select the removable drive

11. Write image.

A. click Flash

B. It might take 20 minutes to write a 20GB (uncompressed) image.

12. Make coffee.

13. When the image is finished writing, close etcher and use the Safely Eject Thing dialog in the system tray.
A. right click

B. select device

14. Unplug your drive from the computer, remove the msata drive drive from the USB caddy and then install into
your embedded device

Adding a LANforge Virtual Machine
Goal: Add a virtual machine running LANforge to a LAN with a physical LANforge manager.
We review the
configuration steps
necessary to add a
virtual LANforge
resource. This was
done using VirtualBox
5.2.10 and Fedora 27
Server edition. The
guest instances will be
configured to export
MAC-VLAN ports to
run traffic on their
physical management
port.

1. Create a new guest instance.
A. When creating the guest, we should use 2 GB of RAM:

B. 20 GB of disk:

C. Omit a floppy drive, use a USB table as pointing device:

D. Allocate two or more cores and PAE/NX:

E. And the usual virtual processor features:

F. We don't need graphics on these nodes, so use minimum graphics memory:

G. Enable RDP access, that is useful. It might be a good habit to allocate separate RDP ports per host,
we'll use 9134 for the first guest, 9135 for the second

H. Enable Host I/O caching for your SATA device. Specify the Fedora 27 Server ISO image as the DVD:

I. Disable Audio

J. Configure the network adapter to:

A. Use the LAN bridged adapter br0
B. Use a server adapter driver
C. Enable Promiscuous Mode to allow sniffing
K. Start the installation

L. Under System Automatic partitioning should be adequate for general use.

A. If you develop on these image (do lots of updates, install new kernels) reserve 1GB for
/boot

M. Set the root password to lanforge . Click Done twice.

N. Add user LANforge:

A. Make user lanforge an Administrator
B. Set password to lanforge
C. Click Done twice
O. When installation finishes, reboot. You will see a login prompt:

P. Login as root . Do updates:
[root@localhost]# dnf update -y
Q. Install perl:
[root@localhost]# dnf install -y perl
R. Set guest's hostname:
[root@localhost]# hostnamectl --static set-hostname atlas-fedora27s01
S. Reboot:
[root@localhost]# shutdown -r now

2. Install LANforge on the guest instance. Start by logging in as root :

A. Use wget (or curl) to download lf_kinstall.txt :
[root@atlas-fedora27s01]# cd /root
[root@atlas-fedora27s01]# curl -o lf_kinstall.pl http://www.candelatech.com/lf_kinstall.txt
[root@atlas-fedora27s01]# chmod +x lf_kinstall.pl
B. You don't need to do a burn in, so toggle that off:
[root@atlas-fedora27s01]# touch /home/lanforge/did_cpuburn
C. Install LANforge:
[root@atlas-fedora27s01]# ./lf_kinstall.pl --lfver 5.3.7 --kver 4.13.16+ --do_all_ct

D. You can disable the VNC Server and Xrdp services on these guests:
[root@atlas-fedora27s01]# systemctl stop vncserver@\:1 xrdp.service
[root@atlas-fedora27s01]# systemctl disable vncserver@\:1 xrdp.service
[root@atlas-fedora27s01]# systemctl daemon-reload

E. You will notice that we have about 6GB of disk space left in this VM

F. When installation finishes, reboot:
[root@atlas-fedora27s01]# shutdown -r now
G. On next boot, you will see a LANforge kernel option, it should be automatically selected:

3. From your LANforge GUI, configure a MAC-VLAN the on default Ethernet port.
A. In the LANforge GUI, choose the Port Mgr tab, and highlight the new enp0s17 port:

B. Click the Create button

C. create one MAC-VLAN port

A. Select MAC-VLAN
B. Quantity: 1
C. Select DHCP-IPv4
D. Click Apply
D. You will see the new port in the GUI:

E. In the guest VM, you will also see the new port:
[root@localhost]# ip a show

4. Add a second VM
A. Shut down the previous VM:
[root@atlas-fedora27s01]# shutdown -r now

B. clone the VM
A. Select the Reinitialize MAC addresses choice, these machine will operate simultaneously.

B. Verify the MAC address of the new guest is set

C. Boot the second guest
C. Change the hostname of the second guest:
[root@localhost]# hostnamectl --static set-hostname atlas-fedora27s02

D. Make sure that the MAC address of the second guest is not listed in the ifcfg-enp0s17 file.

A. Compare the adapter to the file:
[root@localhost]# cd /etc/sysconfig/network-scripts
[root@localhost]# cat ifcfg-enp0s17
B. If it is listed, change it or remove it.

E. LANforge changes the /etc/udev/rules.d/70-persistent-net.rules file, edit tht file those as to
match the value of your mac address.
[root@localhost]# cd /etc/udev/rules.d
[root@localhost]# ip li show enp0s17
[root@localhost]# cat 70-persistent-net.rules
F. Stop LANforge and change the resource ID for this guest:
[root@localhost]# service lanforge stop
[root@localhost]# cd /home/lanforge
[root@localhost]# ./lfconfig
Your command: resource 5
Your command: config

G. Reboot the second guest:
[root@localhost]# shutdown -r now
H. Start up your first guest (resource 4)
I. In your LANforge GUI, you should see your two VMs.
J. Create a MAC-VLAN port for the second guest

5. Create a VOIP connection between the two guests.
A. In the VOIP tab, click Create

B. You configure:

A. Side-A will be resource 3
B. Side-B will be resource 4
C. Click Apply
C. See the newly created connection:

D. In the VOIP/RPT tab, click Start
E. Monitor traffic on the connection with the Modify->View button

Configuring Serial Connection to
LANforge
Goal: Using a serial cable and terminal emulator on Windows to connect to LANforge.
If you experience crashes or system misconfiguration, a network link
to LANforge can become unavailable. LANforge machines are
shipped with a serial cable for just this possibility. Most LANforge
servers come with standard RS232 DB9 pin serial ports, other models
have a special RJ45 style connector. You might need a USB to Serial
adapter to connect your laptop to the serial cable.

1. Connect Serial Cable to LANforge
A. We will use a CT525 for our example There are two different types of CT525, some have a I/O shield
with colors, others do not. Both have DB9 serial ports:
B. Picture of an unmarked I/O plate:

C. Picture of a colorized I/O plate:

D. Picture of a colorized I/O plate plugged in:

E. Other LANforge chassis models can have either RJ45 or DB9 serial ports.

2. Connect Serial Cable to Windows
A. Chances are you will be connecting a USB to Serial adapter to your laptop.
B. Typically, right after you connect the cable to your USB port, you will see a message from Windows
letting you know a new drive has been installed.
C. Windows will map this USB adapter to a COM port. Use Device Manager to discover the new COM
port:
A. Press the Windows key and type device manager

B. Hit Enter to open the Device Manager
C. In Device Manager , select Ports

D. In this example, we see that our new USB device was assigned COM3 .

3. Configure PuTTY to connect to serial port

A. Press the Windows key and search for putty

B. When you double click on the PuTTY icon and it launches, you can start customizing your session
preferences

C. Start by setting your connection type (serial), serial device (com3) and speed (115200). Name your
session 'com3'

D. Select category Serial, specify the Serial Line COM3, speed (115200) and set both Parity and Flow
Control to None.

E. Select the Session→Logging category, select Printable Output and name set the Log file name as
you prefer. This allows you to collect your commands as notes for later.

F. Select the Session category, save the com3 profile and click Save

G. Click the Open button. You will see a terminal window appear.

4. Use PuTTY to Log In over COM3
A. If the screen is blank, hit Enter to see a login prompt.

B. Enter username lanforge Enter , password lanforge Enter

5. Collect console output to a logfile
A. step 1

B. step 1

6. Common Commands Cheat Sheet: Hit Enter after all commands
A. pwd Enter ⋮ print current directory
B. ls Enter ⋮ list items in directory
C. cd Enter ⋮ change to your Home Directory
D. cd /home/lanforge Enter ⋮ go to LANforge home directory
E. cd /root Enter ⋮ go to root user's home directory
F. sudo ./serverctl.bash restart Enter ⋮ Restart LANforge service

G. sudo reboot Enter ⋮ reboot machine
H. ip a show Enter ⋮ show interface addresses
I. df -h Enter ⋮ show disk usage
J. mv script.sh.txt /home/lanforge/scripts/script.sh Enter ⋮ move file to new name
K. dos2unix script.sh Enter ⋮ Remove DOS/Windows CRLF style line endings
L. chmod +x script.sh Enter ⋮ Turn script executable
M. ./script.sh Enter ⋮ Run script in current directory

7. Example of clearing disk space on a LANforge machine
A. One common problem with any LANforge machine is cleaning out old kernels. This is an example
that shows you how to check disk space and how to remove unused kernels.
B. Check disk space with the df -h command

C. Use the dmesg command to see if there are system warning.

D. go to the /boot directory. The uname -r command tells you which kernel you are currently running.
You may remove old ct kernels.

E. In addition to removing old kernels, you can remove modules that correspond to those kernels

F. After old kernels and modules have been removed, we re-run grub2-mkconfig to regenerate the
boot menu:

G. the results will look like this:

Connecting SMA Cables to LANforge
Goal: Connect the antennas of your device under test to LANforge using SMA cables and a
fixed attenuator.
Many WiFi testing scenarios benefit
from some amount of WiFi isolation.
Connecting the radios of the
Device Under Test (DUT) to
LANforge's radios using SMA cables
can improve connection quality.
Using a fixed attenuator can
reduce a direct signal so that it is
heard by the radios without
distortion.

1. The polarities of the cables must match

2. Begin by connecting the SMA Female end of the fixed attenuator to the SMA adapter.

3. We see that the exposed end of the sma_adapter is RP-SMA-Male. RP means Reverse Polarity.

4. Connect the attached attenuator and adapter to the LANforge radio antenna. This exposes the SMA Male
end of the attenuator. Your DUT might not have adequate space to mount a fixed attenuator to it, so we
suggested connecting it to the LANforge.

5. The polarities of the cable end must match the end of the fixed attenuator. The cable end for this side is
SMA-Female.

6. See how the cable connected to the lanforge has both the adapter and the attenuator. It should be safe to
use the attenuator and adapter anywhere along a SMA path.

7. Connect the other end of the cable to the Device Under Test (DUT). Your DUT might use different antennas
so you might need to use another adapter.

8. We have connected one antenna of our DUT to the one antenna of our LANforge. Repeat this for multiple
antennas.

Diagnose Problems with GUI on Windows
Goal: Learn how to diagnose problems running LANforge client on Windows.
The LANforge client (GUI) can encounter variety of difficulties
depending on the amount of RAM and version of Java running on
your desktop. Read this guide to learn steps to take to collect error
messages and how to fix out of memory problems.

i

The LANforge client can be both the GUI running
interactively, or in headless HTTP mode.

1.

Run the client from a CMD window

2. Right click on LANforge GUI icon and select Open File Location

3. You will see the folder wher the LANforge client is installed

4. Right click on folder area to right of files, and select Run CMD here or Run PowerShell here. This might require
that you Shift-Click on anything that might be selected in the directory to un-select it.

5. You will see a terminal window open

6. Start the client using the command .\lfclient.bat ENTER

A.

7.

i

Double-clicking lfclient.bat in the Windows Explorer window will start
the client in a CMD window, but the window will disappear when the client
quit/exits/leaves.

Be Aware of Quick Edit
A. Quick Edit allows you to highlight text quickly with the mouse; it is a feature of both the CMD and
PowerShell windows. CMD windows have the distinct drawback of halting execution while text is
highlighted.
B.

i

Press ESC to clear text selection

C. You can change the setting by clicking in the upper left corner, selecting Preferences, then look for
Qui,ck Select.

For more information see Windows Server 2016 Features

Copy an Error

8.

9. Candelatech introduces features into LANforge quickly, and discovering a problem in the LANforge Client
occasionally happens--and we want to hear when it does! You can help by copying the terminal output
and emailing it to us (at support@candelatech.com). Various kinds of errors leave messages we can find in
the terminal like when the LANforge client:
A. ...will not start after double clicking the icon. This might be caused by a missing or mismatched
version of the Java runtime, an error in the start-up script, or a program error.
B. ...unexpectedly quits. Probably a program error.
C. ...does not respond. Possibly a program error, caused often you will see many exceptions printed to
the terminal.
10. A Java exception is a rather long list of method calls (a stack trace) that starts with the exception message.
Sometimes the exception message is IllegalArgumentException , sometimes it is null (a null pointer
exception)
11. Scroll the terminal window to see the top of the exception and highlight the exception message and as
much of the stack trace as possible. Below is a picture of a condition where the LANforge client script has an
error and will not start.

A. Pressing Enter after highlighting the text copies the text into your clipboard.

B. The laptop might not have an email client installed. In that case, open notepad.exe or wordpad.exe
from via the Start menu, and paste your stack trace into your text editor.

C. If your circumstances don't allow highlighting, copying and pasting, you can take a screen capture,
usually by pressing Alt + PrtScr shortcut.
D. When contacting us, please describe the steps you took to reach this error. We need to be able to
reproduce the error in order to fix it.

12.

Out of Memory Conditions

13. Candelatech provides a 32-bit and a 64-bit version of the LANforge client. We generally suggest people use
the 64-bit client, because most recent laptops are running 64-bit operating systems. This is a common fix for
running out of memory. For more information see LANforge Downloads
14. When running a WiFi Capacity Test, the generated report consumes significantly more memory than a mere
HTML or PDF version of the report does. If you have multiple WiFi Capacity Test reports open, we suggest you
save them and close the report windows.
15. Running tests for longer periods of time (like days) can also consume significant memory. By default, the
LANforge client will only allocate up to two-thirds (2/3s) of the system memory it detects available at start-up.
If there are programs like Chrome, Outlook and possibly Electron based applications open, those can be
using most of your laptop's memory to begin with. You might need to exit other programs in Windows and
restart the LANforge client in order allow it to have more memory.
16. You can also edit the start-up script to configure the maximum memory permitted to the Java runtime. That
is discussesd next.
17.

Edit the start-up script

18. While it is possible to edit files with notepad.exe , that text editor has few conveniences. Please consider using
Notepad++ if you don't already have a text editor available. For more information see Download
Notepad++
19. Right click on the lfclient.bat startup script, and select Edit with Notepadd++

A. The file opens in the editor at the top. You will want to jump to the end of the file.

B. At the end of the file, notice the -Xmx option for the java program. You will edit this to the maximum
amount of memory you want to allow the program.

C. In this example, we've edited the start up script to request 2GB of memory. If you request more than
the system will give you, the Java will give you an error and quit.

For more information see Tuning Java Machines

20.

Email support@candelatech.com if you have questions or need help.

Recovering Filesystems
Goal: Recover a LANforge system that boots into Emergency Mode
If your LANforge boots into Emergency Mode, your system is
experiencing file-system corruption. Follow these instructions to
check the filesystems. This process will require a monitor and
keyboard or a serial cable connected to the LANforge.

i

File system corruptions are caused by power-off
events without properly shutting down the system

1. The emergency mode prompt looks similar to this:

Give root password for maintenance
(or type Control-D to continue):

A. The messages beforehand that begin with [ OK ] can be ignored.
B. Messages beginning with ath10k_pci can be ignored.

2.

i

We assume you'll press the Enter ( ↲ ) key when executing the commands in
further examples.

3. Provide the root password: lanforge
4. The we next need to determine where our filesystems are mounted. You might have filesystems on partitions,
or on LVM volumes. Use the command mount | grep ext4 to find your partitions:

# mount | grep ext4 ↵
/dev/sda2 on / type ext4 (rw,relatime,nodelalloc)
/dev/sda4 on /home type ext4 (rw,relatime,nodelalloc)
/dev/sda1 on /boot type ext4 (rw,relatime,nodelalloc)
This example shows partitions.

i

Note that inspecting /etc/fstab often does not show you device partitions,
rather it shows you volume or partition UUIDs.

5. Example of filesystems on volumes:

# mount | grep ext4 ↵
/dev/mapper/fedora-root on / type ext4 (rw,relatime,nodelalloc)
/dev/mapper/fedora-home on /home type ext4 (rw,relatime,nodelalloc)
/dev/sda1 on /boot type ext4 (rw,relatime,nodelalloc)
Notice that /boot is typically not a LVM volume.
6.

Issuing the fsck commands

7. For each of those filesystems in the partition example above, you will execute the below commands:
A. # fsck -fy /dev/sda2 ↵ (for /)
B. # fsck -fy /dev/sda4 ↵ (for /home)
C. # fsck -fy /dev/sda1 ↵ (for /boot)

8. For the volumes example above, you will execute the below commands:
A. # fsck -fy /dev/mapper/fedora-root ↵ (for /)
B. # fsck -fy /dev/mapper/fedora-home ↵ (for /home)
C. # fsck -fy /dev/sda1 ↵ (for /boot)

9.

Configuring Filesystems Check on Reboot

10. The commands below involve setting the 'mount count' parameter to 1. Every time the filesystem is mounted,
it will perform a check. The following examples ensure that full journaling is enabled on the filesystem. This
ensures the most amount of recovery. And after that, modern versions of Fedora have metadata

checksumming available. Older LANforge systems do not have this.
A.

Filesystem Check on Every Mount
The filesystems do not need to be unmounted to set this parameter. Only the partition example is
shown, the volumes example uses similar commands.
A. # touch /forcefsck ↵ (this technique works with any model of filesystem)
B. # tune2fs -c 1 /dev/sda2 ↵ (for /)
C. # tune2fs -c 1 /dev/sda4 ↵ (for /home)
D. # tune2fs -c 1 /dev/sda1 ↵ (for /boot)

B.

Tune the Filesystem for Full Journaling
The filesystems do not need to be unmounted to set this parameter. The commands for the volumes
version is similar to the partition example below.
A. # tune2fs -o journal_data /dev/sda2 ↵ (for /)
B. # tune2fs -o journal_data /dev/sda4 ↵ (for /home)
C. # tune2fs -o journal_data /dev/sda1 ↵ (for /boot)

C. Note: Inspect /etc/fstab for conflicting mount options. The folling example shows mount options
applied in the fstab file:

$ mount | grep ext4 ↵
/dev/sda2 on / type ext4 (rw,relatime,nodelalloc)
/dev/sda4 on /home type ext4 (rw,relatime,nodelalloc)
/dev/sda1 on /boot type ext4 (rw,relatime,data=writeback)

$ grep data= /etc/fstab ↵
UUID=1c1b4732-653f-47dd-a106-ae17cf5b12a9 /boot ext4 data=writeback

1 2

Notice the fstab entry for /boot ? It has overridden the data journaling mode. Erase that setting from
the fstab mount options.
D.

Enable Metadata Checksumming (optional)
It is only practical to apply metadata checksumming in the below conditions. You will not be able to
apply it to the root filesystem / because it cannot be unmounted when you boot the system.
A. Fedora 27 or more recent
B. tune2fs 1.43 or more recent
C. crc32c or libcrc32c modules loaded
D. you can unmount the filesystem.

E. To Boot into Emergency Mode, follow these steps:
A. Reboot system into Emergency Mode by appending the word emergency at the end of
your grub boot option.
B. # umount -f /home ↵
C. # umount -f /boot ↵
D. # fsck -fD /dev/sda1 ↵ (remember that's /boot)
E. # fsck -fD /dev/mapper/fedora-home ↵
F. # tune2fs -O metadata_csum /dev/sda1 ↵
G. # tune2fs -O metadata_csum /dev/mapper/fedora-home ↵
F.

Disable Drive Write Caching (optional)
Drives typically ship with write caching enabled for a performance boost. SSDs have this as well. By
turning it off you trade some performance for increased data safety. LANforge systems do not ship
with write caching disabled. To make this setting enabled every boot, it needs to be added to
/etc/rc.local . LANforge systems have rc-local.service enabled by defualt.

i

Only disable write caching if your machine powers off without shutdown
frequently

A. # vi /etc/rc.local ↵
B. Add the line /sbin/hdparm -W0 /dev/sda
C. Save the file.
D. Reboot, or issue the command for this booted session:

# /sbin/hdparm -W0 /dev/sda ↵

Automatically Start LANforge GUI
Goal: Configure LANforge to automatically start LANforge GUI on boot or login.
Follow these steps to Configure LANforge to automatically start
LANforge GUI on boot or login. Requires version 5.4.1

1. Quick Start
A. Open a terminal or connect to your lanforge machine via ssh:
B. $ cd /home/lanforge/LANforgeGUI_5.4.1
$ cp LANforge-auto.desktop ~lanforge/.config/autostart
$ sudo systemctl restart vncserver@:1.service
C. If you were connected via VNC, your session will close. When you reconnect via VNC, you will see a
LANforge GUI running on the desktop. This will now start again every reboot.

Using desktop file manager

2.

A. Locate your LANforge GUI Folder by right clicking on your LANforge GUI icon

A. Right-click your LANforge GUI icon
B. Select Properties
B. Your LANforge GUI directory is in the Command textbox:

C. Using the HOME desktop icon, navigate to the LANforge GUI directory

D. Highlight the LANforge-auto.desktop file, it might appear as LANforge client

E. We need to show hidden directories to place this file.

A. Using the HOME desktop icon, open your home directory and open the Edit->Prefreneces
menu
B. Select Show Hidden Files

F. Find your .config directory

G. Navigate to /home/lanforge/.config/autostart

H. Copy and paste file into the autostart directory.

I. In a terminal, issue the command: sudo systemctl restart vncserver@:1.service

J. If you were connected via VNC, your session will close. When you reconnect via VNC, you will see a
LANforge GUI running on the desktop. This will now start again every reboot.

Configuring OpenVPN on Ubuntu
Goal: Connect your laptop to a VPN with the provided keys and configuration file.
Connecting to the office network remotely requires you to install the openvpn package and place the config
files in the correct places. You can start and stop the VPN using simple commands at a terminal.

Install OpenVPN

1.

2. Open a terminal and see if you already have openvpn installed:
$ which openvpn
/usr/sbin/openvpn
This means you have OpenVPN installed.
3. Installing openvpn is a simple command:
$ sudo apt install openvpn
4.

Add your Config Files

5. You should be provided with these files:
A. your-laptop.key ← This is your private key
B. your-laptop.crt ← This is your certificate
C. ca.crt ← This is the VPN server certificate
D. candelatech.conf ← The config file for the connection

You will place these files in /etc/openvpn . The files should be owned by root, so become root and copy
them with this technique:
$ sudo -s
[/home/amelia] # cd /etc/openvpn
[/etc/openvpn] # cp ~amelia/Downloads/your-laptop.key .
[/etc/openvpn] # cp ~amelia/Downloads/your-laptop.crt .
[/etc/openvpn] # cp ~amelia/Downloads/ca.crt .
[/etc/openvpn] # cp ~amelia/Downloads/candelatech.conf .
6.

Starting and Stoping the VPN Connection

7. In a terminal, cd to /etc/openvpn and start the connection as root:
$ cd /etc/openvpn

$ sudo openvpn candeltech.conf
Press Control-C in that window to stop the VPN connection.

Example Config File

8.
9. client
dev
proto
remote
#remote
script-security
resolv-retry
nobind
persist-key
persist-tun
verb
ca
cert
key
comp-lzo
cipher

tun1
udp
firewall.candelatech.com 1194
firewall.candelatech.com 443
2
infinite

3
ca.crt
laptop-dell.2019-08-13.jreynolds.candelatech.com.crt
laptop-dell.2019-08-13.jreynolds.candelatech.com.key
AES-256-CBC

Configuring OpenVPN on Windows
Goal: Connect your laptop to a VPN with the provided keys and configuration file.
Connecting to the office network remotely requires you to install the openvpn package and place the config
files in the correct places. You can start and stop the VPN using simple commands at a terminal.

1.

Install OpenVPN

2. Download and install the latest version of OpenVPN GUI on windows.

The list of packages to download is at the bottom of the page:

For more information see Openvpn Community Downloads
3. In your Downloads folder, double click to start the installer.

4. When the installer asks you what components to choose, you just need those necessary for being a client.
You do no need to install the EasyRSA script package.

Add your Config Files

5.

6. OpenVPN keeps configuration files in C:\Program Files\OpenVPN\config. Open this folder with Windows
Explorer.

7. You should be provided with these files:
A. ca.crt ← This is the VPN server certificate
B. your-laptop.key ← This is your private key
C. your-laptop.crt ← This is your certificate
D. candelatech-udp.conf ← The config file for establishing a UDP connection. This is the faster type of
connection.

E. candelatech-tcp.conf ← The config file for establishing a TCP connection. TCP OpenVPN
connections do not perform as well, and are useful if you are in an environment that only allows
outbound TCP port 443.

You will place these files in C:\Program Files\OpenVPN\config. you will probably be asked to give your
password because the folder is owned by Administrator .

8. Double click the OpenVPN GUI icon. If you see a warning message about no configuration files found, we're
about to fix that in the next step. Click OK.

Configuring OpenVPN

9.

10. When the OpenVPN software starts, it places an icon in the system tray.

i

Click on Taskbar up arrow ⋀ to see hidden taskbar items

11. Right click the Screen with Padlock icon to see the menu. Select Settings.

12. You will see the Settings→General tab. Here you can set OpenVPN to start automatically if you desire.

13. Click on the Advanced tab. You will alter these settings:

A. Change the Configuration Files→Folder value to where you saved your config files.
B. Change the Configuration Files→Extension value to conf .
C. Change the Log Files→Folder value to where you want to find your connection logs.
D. Click OK

Editing your Config File

14.

15. The candela-udp.conf configuration file is going to be formatted for a Linux machine. You will need to
change the location of the certificates to absolute Windows paths.

i

Backslashes \ need to be escaped: \\

i

Any paths with spaces need to be " double-quoted " ;.

16. Here is an example file you can highlight and copy:
client
dev
proto
remote
#remote
script-security
resolv-retry
nobind
persist-key
persist-tun
verb
ca
cert
key
comp-lzo
cipher

17.

tun1
udp
firewall.candelatech.com 1194
firewall.candelatech.com 443
2
infinite

3
ca.crt
"C:\\Program Files\\OpenVPN\\config\\laptop-dell.2019-08-13.jreynolds.candelatech.com.crt"
"C:\\Program Files\\OpenVPN\\config\\laptop-dell.2019-08-13.jreynolds.candelatech.com.key"
AES-256-CBC

Starting and Stoping the VPN Connection

18. After saving your config files, return to the taskbar to start an openvpn connection:

A. Click on Taskbar up arrow ⋀
B. Right click on the Computer with Padlock
C. Select your connection name
D. Select Connect

CI/CD Lights-Out Chamber Setup
Goal: Assemble a LANforge and a device under test (DUT) to operate in an unattended lab
setup.
The CI/CD lights-Out chamber is composed of a CT840a chamber, a CT523c LANforge
and a test-controller*, that connects to them via serial and Ethernet.
*) A test controller is a Linux system that can be remotely accessed, and does not need LANforge installed.

Inside the chamber we have:
a remotely controlled power switch
a powered USB hub for connecting serial ports of the LANforge and DUT
a LED lamp
a USB camera connected to the LANforge machine
a short table to place above the LANforge for the DUT
the LANforge machine
the DUT
Once assembled, this setup can perform a battery of connectivity and traffic tests that
do not require a programmable attenuator. Requires LANforge 5.4.2.

1.

Parts review
Let's review the parts the chamber setup requires:

A. Cables include:

A. 3 cat5e cables
B. 2 cat6 cables
C. 1 USB serial adapter
D. 1 DB9 female-female cable
E. Also shown are annenas, with-pin

B. You will also get two small monitor stands and a network power switch. You will be using the legs of
both, but discarding one of the stand tops.

C. You will be getting a LED lamp, a USB camera, 8 port network switch, USB hub, camera clamp, USB
A-A cables.

D. Your chamber will come with a universal power strip, AC power cord, fan AC-DC power adapter,
and a printed test report. This assembly guide does not use the universal power strip. You might find
a use for it.

E. Your chamber will also come with a brass pipe mounted to a steel plate. This is a fiber tube that you
can pass fiber optic cabling through. For this setup, you can refrain from installing the fiber-pipe. It is
not necessary because we are using copper Ethernet cabling.

2.

First items

A. Place the lamp in the chamber

B. Place the power distribution unit (PDU) in the chamber on it's side.

C. Plug the DC barrel connector for the fans into the fan power supply

D. Plug the USB hub USB cable into back of the chamber. The bottom USB port is chamber USB 1
near the top ethernet filter port 3 . The top USB port is chamber USB 2 .

Power Switch

3.

A. Port 1: USB Hub
B. Port 2: Interior Light
C. Port 5: 5 Chamber Fans
D. Port 6: LANforge system
E. Port 7: DUT
F. Others are un-labeled. If you want to add an Ethernet switch in here, we suggest plugging it into one
of the always on ports on the right side.

4.

Assemble the USB camera

A. Your camera clamp and USB camera. Your USB camera might be manual-focus.

B. Screw the bolt of the clamp into the tripod mount of the camera

C. Tighten the clamp to the arm of the lamp near the top joint. The USB cable should be plugged into
the LANforge when it is added. If you plug it into the USB hub, only the test-controller will be able to
use it.

5.

6.

Check espresso levels in human system

Power cables

A. Plug the PDU cable into the rear of the chamber
B. Plug the USB hub power into port 1
C. Plug the lamp cable into port 2
D. Plug the chamber fan AC cable into port 5
E. Plug the LANforge power-supply into port 6
F. You will probably plug in your DUT power supply last, into port 7

7.

Inline Attenuators
A. This is an SMA connector chart. Make sure your antennas and in-line attenuators have the correct
pins

B. Your 16 LANforge SMA terminals are SMA-Female.

C. Screw 16 SMA-Male/SMA-Female inline attenuators onto your CT523c.

8.

Antennas
A. Check that you have SMA-Male antennas (antennas are with-pin).

B. Screw on your antennas. You will not leave them straight like this.

C. Bend the antennas various ways to ensure they provide diversity. Not providing diverse antenna
orientation means your equipment will not reach desired MCS rates.

9.

Shelf for DUT

A. You are provided two monitor stand kits as to combine into a shelf for the DUT to rest above the
LANforge CT523c. You are going to use the legs from the second kit to extend the legs of the first kit.

B. Use a utility knife or a screw driver to separate any feet from legs sections you do not need.

C. Here is a shelf with five segments per leg. Depending on the size of the rubber feet on your CT523c, it
might be just tall enough. The other photos show a table with six segments per leg. Looks like Batman
likes my work.

D. This table clears the LANforge unit well.

10.

Network and Serial Cables
A. The network ports on the chamber are passive Ethernet RF filters. The do not have activity lights, they
do not require power.

A. The top USB3 port is USB 2
B. The bottom USB3 port is USB 1
C. The top Ethernet port is 3
D. The middle Ethernet port is 2
E. The bottom Ethernet port is 1

B. Cable the PDU network to chamber Ethernet port 1

C. Place the LANforge CT523c in the chamber and attach a CAT5e cable to the management port
labeled [ MGT ]

D. Plug the management port cable into the chamber port 2

E. Use a CAT6 cable to connect the LANforge [ eth3 ] port to the chamber 3 port. This represents
your WAN connection.

F. Connect the DB9 female-female serial cable to the CT523c serial port. It is labled Serial: 115200
8n1 . Connect the USB serial adapter to the other end of the DB9 cable.

G. Plug the USB end of the USB serial adapter into the USB hub. Your test controller will be able to login
to the LANforge for network configuration and debugging.

H. Plug in power to the CT523c. It is a green DC connector. Place the table over the CT523c.

I. You may place the DUT on the table. Use a CAT6 cable to connect the DUT to the LANforge [ eth2
] port. LANforge will serve DHCP on [ eth2 ] for the DUT and its connected stations, and will NAT

and route packets out of [ eth3 ].

J. Plug your DUT power to into PDU port 7

K. Your DUT probably has a serial connector. Cable your DUTs serial cable into the USB hub.

11.

Controller Setup

A. The test controller (aka Jump Host) pictured here is a 1U rack unit.

A. Your rack KVM will use the left USB2 ports and VGA port of the test-controller.
B. Connect chamber port USB 1 to a USB3 port on the test-controller.
C. You might have to use an extra USB3 hub to control more than two CT820a chambers.
D. Cable chamber ethernet 1 to switch, this is your PDU
E. Cable chamber ethernet 2 to switch, this is your LANforge management port.
F. The picture shows chamber ethernet 3 connected to the switch. This connection is at
your discretion. You might have a different WAN upstream network to attach to chamber
ethernet 3
G. The USB ports may be renamed each time the system restarts. To fix this, you can create an
/etc/udev/rules.d/81-usb-serial.rules file that defines the USB ports by name using the
serial-number of the USB cable if it supports it, or the path (effectively port to which the USB
cable is connected).
#LF on cable with serial number
SUBSYSTEM=="tty", ENV{ID_SERIAL_SHORT}=="AK066NLY", SYMLINK+="ttyLF1",
MODE="0666"
# AP
# In case we have something w/out a serial number
SUBSYSTEM=="tty", DEVPATH=="1-2.1.4", SYMLINK+="ttyAP1", MODE="0666"

You can find the appropriate information with the udevadm info -n /dev/ttyUSB0
command.

B. In the picture the red cable represents the control network. The yellow cable is your connection to
your test controller ETH0

Changing the logo generated in GUI
reports
Goal: Correctly access and change the logo displayed at the top of GUI-generated reports
in your local Lanforge GUI.

1. Open your LANforge GUI, click on Reporting, and Reporting Manager

2. Click on Generate Report

3. Find a desired image instead of the default report logo that fits the report logo size (within 200 x 90 px size
range) and save the image into the html/images/ path within the bt_bits directory.

4. Once the desired image is within the appropriate images folder, scroll over back to the Reporting Manager
tab, click on Report Logo and select the image (and image path) to be placed in the Report logo path.
Then select Report Logo. Now, once a user generates a report, the new report should print out with a
different logo at the top.

Set up an SSH-tunnel on Windows, Linux,
or Mac
Goal: Connect to a LANforge Linux system via a compressed tunnel connection
When connecting to
your remote LANforge
hardware (presumably
accessible over a
VPN) you will notice
poor response time
and lag in your
LANforge GUI or your
VNC connection.
Many VPN
connections are
based on UDP
protocols and packet
loss might be affecting
your connection
quality. Below we
explain how to set up
SSH tunnels that
increase the quality of
your connection.

1. Linux SSH tunnel Setup
A. From the computer that you are trying to connect your SSH tunnel from, open the .bashrc file from
'/home/user/'. The .bashrc file can be opened via gedit, vim, or nano. This .bashrc file is where the
alias will be setup to properly invoke your ssh.

B. Once the .bashrc file is open, type in your alias in any blank spot (that is not within another for-loop
or definition). Flags used in the bash alias creation example below are as followed:
A. -C = Requests compression of data. This is desirable for slower connections.
Recommended.

B. n = redirects stdin /dev/null. Required when SSH is running in the background.
C. N = do not execute a remote command, useful for forwarding ports.
D. v = Verbose mode. Causes SSH to print debugging messages about its progress.
E. -L = bind_address:port:host:hostport format. Use this flag multiple times to
forward multiple ports with one command.

F. Please visit the SSH man page for further flags and
switches: https://linuxcommand.org/lc3_man_pages/ssh1.html

C. The generic setup of bash aliases for SSH are ssh -flags localport:ipaddress:remoteport. In the
example included above we've included the following ports for the according reasons:

A. 4001 -- perl scripts use this for ascii connection to LANforge server
B. 4002 -- GUI uses this for binary connection to LANforge server
C. 5901 -- VNC port for display :1
D. 4131 -- local port for perl scripts to connect to .92.12
E. 4132 -- local port for GUI to connect to .92.12
F. 5903 -- local port for VNC to connect to .92.12
D. Further example ssh aliases include:

A. alias FreyaTunnel="ssh -CnNv -L 5903:192.168.0.6:5901 -L 4131:192.168.0.6:4001
-L 4132:192.168.0.6:4002 lanforge@192.168.0.6"

B. alias SaltTunnel="ssh -CnN -L 4001:192.168.200.18:4001 salt@10.253.1.6"
E. After editing the .bashrc file, source the file in order for the changes to be applied. This will enable
the code without the need to turn off and restart the device.

F. In order for our machine to remember certain passwords and access configurations, some
additional edits in the ~/.ssh/config file or $HOME/.ssh/config.
G. Next, this ssh connection will require an ssh key. This means that one needs to be generated. The
private key and public key of the key pair must be saved to the local computer while only the public
key of the pair must be saved to the remote server.
H. Add your SSH key to the device being forwarded. Finally, add your public key that you generated
earlier via SSH. This can be done by typing in ssh-copy-id user@ipaddress (see below example).

I. Once the alias is added to .bashrc file and the ssh key is added to the remote device, open any
terminal and simply type in the alias name. This will initiate the tunnel. For example, "FreyaTunnel" in
this example would be the alias typed into any terminal. This should incur an instance of your tunnel.

2. Windows SSH tunnel Setup
A. There are many ways to set up an SSH tunnel, however, this cookbook will utilize PuTTy.

B. Once PuTTY is downloaded, configure the SSH connection before adding the tunnel. For more
information see Connecting with PuTTy.

C. Once your session is setup, select your session that was just saved from the last cookbook, then on
the left-hand panel, select Connection -> SSH -> Tunnels.

D. After setting up the tunnel, select SSH and enable compression. This will ensure that the tunnel uses
data compression.

E. Once all the settings desired are configured, select Session, highlight the session again in Saved
Sessions and hit Save for the new session settings. This will make sure that the next time logged in will
include all the settings here.

F. Now, the session is saved and can be opened by clicking Open

Understanding VRF Devices
Goal: Understand and inspect private VRF routing tables.
VRF devices are a Linux kernel
networking driver that allows
private routing tables for individual
ports in the system. The examples
below show how to find these
routes. Requires version 5.3.9

VRF Driver

1.

LANforge has been using the Virtual Routing and Forwarding driver since around 2018. This allows private
routing tables for each LANforge managed interface. VRF provides specific networking benefits to
LANforge:
A. Virtual stations gain authentic routing as delivered from the AP's DHCP service. IP sockets
bound to that station will not send DNS requests out the host's default gateway, for
instance. This helps accurately test captive portal and HS2.0 web requests that should
never know about the management network.
A.
B. Multiple identically numbered networks can be modeled in parallel. Emulating a peer-topeer VPN tunnel between two STA devices that both are on 10.0.0.0/24 networks
separated by a WAN.

Disabling VRF

2.

This does make it more difficult to monitor the routes per port.
3. If this feature is undesirable, you can use the following command to disable VRF:
A. $ touch /home/lanforge/LF_NO_USE_VRF
B. $ sudo reboot

Finding VRF private routes

4.

To find the routes, you want to use these commands for any particular vrf device:
A. Look for the station's master device:
$ ip a show wlan3
wlan3: mtu 1500 qdisc noqueue master _vrf6 state DOWN mode DEFAULT group default qlen 1000
link/ether 00:0e:8e:44:07:a1 brd ff:ff:ff:ff:ff:ff promiscuity 0 minmtu 256 maxmtu 2304

B. When you know the master device you can display that specific routing table:
A. A routing table with a gateway:
$ ip route show vrf _vrf10
default via 10.40.0.1 dev br0
10.40.0.0/20 dev br0 scope link src 10.40.0.21

B. With no default gateway:
$ $ ip route show vrf _vrf15
unreachable default

Use FireFox with a virtual station to Browse
a DUT
Goal: Use FireFox with a virtual station to Browse a DUT
Access points used as a DUT in a wireless-mesh scenario might not have an ethernet port available to be able
to access their management screen. Rather, they require a station to associate to the DUT to access the
management console. LANforge virtual stations operate in the context of a VRF (virtual routing) device that
protects them from the default routing table of the system. This makes using a browser over a station unintuitive;
special commands are required to do this. Requires LANforge 5.3.9 or later.

Associate a station to your DUT

1.

A. Create a station as necessary or use the wlan0 device
A. if you know the SSID credentials, enter those.
B. If you need to discover the SSID, enter anything into the SSID box, like asdf so you can start
a scan.

For more information see Create stations
B. Scan for your DUT SSID.

C. Configure your station to use the DUT SSID credentials and DHCP.

2.

Use the vrf_exec.bash script to start Firefox
The vrf_exec.bash script changes the networking context for the browser so it can use your station.
A. Open a terminal
B. Become root: $ sudo -s ↵
C. Go to the LANforge directory: $ cd /home/lanforge ↵

D. Start firefox: $ ./vrf_exec.bash wlan0 firefox http://10.0.0.1/ ↵

Possible difficulties

3.

If you have just rebooted your LANforge system and are jumping to step 2 without starting the LANforge GUI,
you might have difficulty getting Firefox to display. By starting the GUI, it runs the xhost + command and
relaxes some basic X11 security settings to let other users display windows on the desktop.

Backing Up and Migrating LANforge Data
Goal: Learn what directories under /home/lanforge are important to backup and transfer to
a new LANforge.
Most of the data that LANforge produces lives in the directory /home/lanforge . Not all
the files and directories under there are useful to backup or migrate to a new LANforge
machine. This guide relates to Linux based LANforge machines.
We will assume for this cookbook during a restore situation you have the two LANforge
systems connected on the same management network.

1. LANforge data lives in various directories under /home/lanforge , and this is a brief explanation of the
directories you will want to transfer.

i

LANforge scenario data for a realm is saved on themanager (typically resource
1).

i

The LANforge client (GUI) can save reports on various machines where it is
running. It does not save scenario data.

2. Below are listed the important sub-directories from /home/lanforge, . Each has a note about how important
it is to back up. Directories not listed are unlikely to contain LANforge related data.

i

When in doubt backing up the entire /home/lanforge directory is OK
A. DB/
YES this is were all your scenarios are saved
B. Desktop/
only if you save things here
C. Documents/
only if you save things here
D. Downloads/
only if you save things here
E. html-reports/
yes if you want the reports
F. lf_reports/
yes if you want the data
G. local/
unlikely unless you customize strongswan
H. report-data/
yes if you want the data
I. scripts/
only if you have modified or custom scripts in here
J. trb_entities/
trb_profiles/

Table Report Builder saved settings only necessary if you use TRB frequently
K. vr_conf/
only if you save virtual router settings, nginx configs or want to save dhcp lease files
L. wifi/
only if you have customized wpa_supplicant.conf or hostapd.conf files

Archiving Data

3.

Starting on your old LANforge machine, use the tar command to archive data. Add directories you want to
archive to the end of the command.
$ cd /home/lanforge
$ tar cjf /home/lanforge-bu.tar.bz2 DB html-reports lf_reports report-data

i

If you run out of space, try using /home/lanforge/check_large_files.bash to
help clear room.

Copy the Archive

4.
Copy the archive to the new LANforge:

$ scp /home/lanforge-bu.tar.bz2 lanforge@your-new-machine-ip:/var/tmp

Restore the Data

5.
On the new machine:

$ cd /home/lanforge
$ tar xvf /var/tmp/lanforge-bu.tar.bz2
$ sudo service lanforge restart

CT714B Stand Assembly
Goal: Fully assemble a stand for CT714B attenuators.

1. Insert rods until they stick out a bit through the bottom.

2. Bottom view:

3. Add nuts to all four rods on bottom side of plate. Hand tighten.

4. Full view:

5. Add one spacer to each rod.

6. Full view.

7. Add the first CT714B.

8. Add another set of spacers.

9. Full view.

10. Repeat steps 4 and 5 until all CT714Bs are stacked.

11. Add washers to all rods.

12. Add wing nuts to all rods.

13. Full view.

14. Add caps to all rods.

15. Full view.

16. The nuts on the bottom can easily come loose during assembly. Tighten again as needed.

Testing the CT840a Turntable
Goal: Use the lf_chamber.pl script to interact with chamber door sensor, lights and turntable.
The CT840a chamber has a Modbus interface that can provide telemetry about the the door-closed sensor,
light control, and turntable control and position. In order to have access to the Modbus protocol, you need a
Modbus package installed on your system. The modbus controller in these chambers is simple and does not
understand IP routing. You have to be connected on the same network as the modbus system.

Using LANforge on Linux

1.

2. Test your connection to the chamber with the /home/lanforge/lf_chamber.pl script. This will verify you can
reach the modbus controller.
Available here: https://www.candelatech.com/downloads/lf_chamber.pl
A. Source the lanforge.profile script:
$ source /home/lanforge/lanforge.profile

B. Use the command:
$ ./lf_chamber.pl --targ 192.168.100.10 --status 1

Expect output similar to:
Current-Angle: 3599 Door-Open: 0 Table-Moving: 0 Lights: 0 Fan: 1 Jog-Speed: 3 Return-Speed: 3
Absolute-Speed: 3 Jog Angle: 0

3. Use the chamber-test.sh script to test all the chamber features.
Availble here: https://www.candelatech.com/downloads/chamber-test.sh

A. $ ./chamber-test.sh 192.168.3.123
The desktop linux is 192.168.3.64, remember to use Alt-F2, 'mate-terminal' to get a shell.
Testing chamber at 192.168.3.123
Please close door.
Current-Angle: 3599 Door-Open: 0 Table-Moving: 0 Lights: 0 Fan: 1 Jog-Speed: 3 Return-Speed: 3 Absolute-Speed:
check output if door is closed: door == 1
Please open door.
Current-Angle: 3599 Door-Open: 0 Table-Moving: 0 Lights: 0 Fan: 1 Jog-Speed: 3 Return-Speed: 3 Absolute-Speed:
check output if door is closed: door == 0
Toggle lights
Did lights turn on?
Current clockwise angle: 3599 counter-clockwise-angle: 1 new-angle: 450
Did platform rotate 45 degrees?
Did platform rotate another 45? It should be at 90
Current clockwise angle: 2978 counter-clockwise-angle: 622 new-angle: 1
Did platform rotate back to zero?
Did fan turn on?
Toggle fan
Did fan turn off?
Toggle lights
Did lights turn off?
Current-Angle: 2700 Door-Open: 0 Table-Moving: 0 Lights: 0 Fan: 0 Jog-Speed: 3 Return-Speed: 3 Absolute-Speed:
You may close the chamber.

Using Linux without LANforge

4.
5.

You will want to download
:
A. LANforgeServer that matches your version of Fedora. For example, Fedora 30 would be
LANforgeServer-5.4.5_Linux-F36-x64.tar.gz
B. The modprobe interface script: lf_chamber.pl
C. The chamber test script: chamber-test.sh

6.

Setup
: This setup is intended for versions of Fedora that LANforge has been compiled for. The version of mbpoll
bundled with the Server archive is specific to the glibc version the Fedora distro is built with. You do not have
to run the lf_kinstall.pl script or use the install.bash script in the LANforgeServer directory.
A. Create the following directories:
sudo mkdir -p /home/lanforge/local/lib
sudo mkdir -p /home/lanforge/local/bin

B. Chown the directories to your current user:
sudo chown -R $USER: /home/lanforge

C. Expand the LANforgeServer archive in /home/lanforge :
tar xf LANforgeServer-5.4.5_F30-x64.tar.gz

D. Copy the mbpoll files to the new directories:
,,cp -r LANforgeServer/local/lib/* /home/lanforge/local/lib,,
cp -r LANforgeServer/local/bin/mbpoll /home/lanforge/local/bin

7.

Run the scripts
: These scripts require the mbpoll libraries in the LD_LIBRARY_PATH. The example below uses the address
192.168.0.3 as the address of the CT840a chamber. Please do not confuse this with the IP of the LANforge
that might be in or attached to the chamber.
A. $ export LD_LIBRARY_PATH='/home/lanforge/local/lib:/usr/lib64'
$ export PATH="/home/lanforge/local/bin:$PATH"
$ ./lf_chamber.pl --targ 192.168.0.3 --status 1

8.

Using Windows without LANforge

9. Not at this time.

Remove old Reports and Data
Goal: Find and remove old reports and test data.
Running tests on LANforge for long periods of time can leave a lot of data behind. The
check_expired_data.bash script can find old files to delete.This file is similar to check_large_files.bash but
looks at the age of files.Introduced in LANforge 5.4.5.

Download the script

1.

Download the script if it is not in /home/lanforge/scripts already. If you need to download the script, use
the following commands:
A. $ cd /home/lanforge/scripts ↵
B. $ wget https://raw.githubusercontent.com/greearb/lanforge-scripts/master/check_expired_data.bash ↵
C. $ chmod +x check_expired_data.bash ↵

Find the script help

2.

$ ./check_expired_data.bash -h ↵
-d
-t
-f
-v

Find data within this directory (required)
Find data this many days old or older (required)
Delete files (not a default option)
Print files

See the files you would delete:
./check_expired_data.bash -d /home/lanforge/report-data -t 11 -v
Actually delete the files:
./check_expired_data.bash -d /home/lanforge/report-data -t 11 -f
You may create a script in /etc/cron.daily like this:
----- ----- ----- ----- ----- ----- ----- ----- ----#!/bin/bash
LF='/home/lanforge'
E='/home/lanforge/scripts/check_expired_data.bash'
$E -d $LF/report-data -t 11 -f
$E -d $LF/html-reports -t 11 -f
----- ----- ----- ----- ----- ----- ----- ----- -----

Running the script is likely places

3.

Places we would expect large amounts of files to be saved include:
A. /home/lanforge/Documents
B. /home/lanforge/lf_data
C. /home/lanforge/report-data
D. /home/lanforge/html-reports
E. /home/lanforge/Downloads

4.

Survey where your data
You can use the df command to get an idea where data is accumulating.
Example: $ df -s * | sort -n | tail ↵
12736
interop-5.4.5.apk
22164
btserver
23500
MonkeyRemote-0.4-shaded.jar
39500
gua.64
116536
local
190444
LANforgeServer-5.4.4
210004
LANforgeServer-5.4.5
262628
LANforgeGUI_5.4.4
267344
backup-lanforge-gui.tar
269196
LANforgeGUI_5.4.5

Please Avoid...

5.

Please avoid running the script in the /home/lanforge directory itself. A command like
./check_expired_data.bash -d /home/lanforge -t 10 -f would delete your LANforge Server, LANforge

GUI and your saved scenarios.

Packet Capture Files
If you are saving PCAP files, please save them in /home/lanforge/Documents or /home/lanforge/reportdata . Please do not save them in /home/lanforge . The check_expired_data.bash script should not be run

with -d /home/lanforge it is too destructive.

Also avoid:
A. /
B. /boot

C. /etc
D. /home
E. /lib
F. /opt
G. /run
H. /usr
I. /root
J. /var/log
K. /var/cache
L. /var/spool
M. /var/www
N. /var/run

Creating a cronjob

6.

As the help text indicates, you can copy those lines into a cron job task that can run daily.
A. $ sudo -s ↵
B. $ cd /etc/cron.daily ↵
C. $ nano expired_data.bash ↵
D. Copy in your script data and adjust:
#!/bin/bash
LF='/home/lanforge'
E='/home/lanforge/scripts/check_expired_data.bash'
$E -d $LF/report-data -t 11 -f
$E -d $LF/html-reports -t 11 -f
E. $ chmod +x expired_data.bash ↵
F. Check for errors by running it by hand:
G. $ ./expired_data.bash ↵

Clustering multiple LANforge systems
together
Goal: Cluster multiple LANforge systems together to use while Wifi network testing. Clustering
enables multiple LANforges to act as one large LANforge.

1. An unclustered LANforge is both 'Manager' and 'Resource'. In a cluster (with multiple LANforges), there is one
LANforge that is a 'Manager' and 'Resource' and there are other LANforges that are only 'Resources'. The
LANforges that are only a 'Resource' use the first LANforge as their 'Manager'. There are two ways to cluster.
One way is via the command line, second is via the User Interface. This cookbook demonstrates how to
cluster via the User Interface. First, configure the first LANforge (which is typically both a 'Resource' and
'Manager')

A. Open a VNC/RDP window to the LANforge wished to be used as the 'Manager' and 'Resource' of
the final cluster. Click on the Configure LANforge icon located on the VNC session desktop.

B. Once the 'LANforge Installation and Configuration (as superuser)' window opens, click on the Basic
tab. Set the Setup Mode to Both, Resource ID to 1, and pick a realm 1-254 (example below is realm
2). Realm 255 means the LANforge is un-clustered.

C. Click on Apply and Exit LANforge Config to save settings.

2. Next, configure the following LANforges to cluster to the first LANforge. These LANforges will be only
Resources.
A. Open a VNC/RDP window to the LANforge wished to be used as the 'Manager' and 'Resource' of
the final cluster. Click on the Configure LANforge icon located on the VNC session desktop.

B. Once the 'LANforge Installation and Configuration (as superuser)' window opens, click on the Basic
tab. Set the Setup Mode to Resource , Resource ID to 2 or what the next unused Resource number is,
and pick the same realm as the manager LANforge (in our example, realm 2).

C. Click on the Clustering tab and in the Connect to Manager input box, put in the Manager's IP
address followed by a ':4002'

D. Click on Apply and Exit LANforge Config to save settings.

3. Restart LANforge Manager on all LANforges of cluster. The 'Status' tab of 'the Manager' of the clustered
systems should show multiple resources now, as shown in the example below. If systems are not clustering
and LANforge version build dates are too far apart between systems in cluster, LANforges may need to be
upgraded so build version dates are closer to each other. Please contact support@candelatech.com for
assistance.
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